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Résumé: 

Le polycopié "Calcul Assisté par Ordinateur avec le logiciel ETABS" s'adresse aux étudiants en 3eme 

année licence Génie Civil. Il vise à familiariser les étudiants avec les logiciels de calcul en génie civil et à 

leur apprendre à dimensionner les éléments d'une structure soumise à plusieurs sollicitations. Il est 

important pour les étudiants de comprendre les caractéristiques essentielles d'un logiciel de calcul, de 

maîtriser son interface, de saisir correctement les données et de récupérer les résultats nécessaires. Les 

prérequis recommandés sont les cours d'informatique 1 et 2. Les premiers travaux pratiques aideront les 

étudiants à comprendre les bases des logiciels de calcul, les différentes méthodes utilisées, les logiciels 

fermés et ouverts, ainsi que les avantages et limites. Ils utiliseront notamment ETABS pour apprendre 

l'interface, le travail avec les données, les options, les résultats et l'interprétation, avant d'analyser un 

projet concret. 

Mots clés : Calcul Assisté par Ordinateur, Etabs, logiciels de calcul, interface 

 

Abstract : 

The handout ‘Computer-aided calculation with ETABS software’  is intended for students of 3rd year 

bechelor Civil Engineering. It aims to familiarise students with civil engineering calculation software and 

to teach them how to dimension the elements of a structure subject to several stresses. It is important for 

students to understand the essential features of calculation software, to master its interface, to enter data 

correctly and to retrieve the necessary results. The recommended prerequisites are Computer Science 1 

and 2. The first practical exercises will help students to understand the basics of calculation software, the 

different methods used, closed and open software, as well as the advantages and limitations. Students  

will use ETABS to learn about the interface, working with data, options, results and interpretation, before 

analysing a concrete project. 

Key words: Computer-aided calculation, Etabs, interface 

 

 

 ملخص

هذا العمل يشمل ملخص دروس الأعمال التطبيقة الخاصة بالحساب بمساعدة الحاسوب باستخدام برنامج إتابس ،و هو مخصص لطلاب 

تهدف إلى تعريف الطلاب ببرمجيات حسابات الهندسة المدنية وتعليمهم كيفية تحديد أبعاد عناصر السنة الثالثة ليسانس هندسة مدنية. و

الهيكل الخاضع لعدة ضغوطات. من المهم للطلاب فهم الميزات الأساسية للبرامج الحسابية وإتقان واجهتها وإدخال البيانات بشكل صحيح 

. ستساعد التمارين العملية الأولى الطلاب على فهم 2و 1موصى بها هي علوم الحاسوب واسترجاع النتائج اللازمة. المتطلبات الأساسية ال

أساسيات البرامج الحسابية، والطرق المختلفة المستخدمة، والبرامج المغلقة والمفتوحة، بالإضافة إلى المزايا والقيود. وعلى وجه 

مل مع البيانات والخيارات والنتائج والتفسير، قبل تحليل مشروع الخصوص، سوف يستخدمون برنامج إتابس للتعرف على الواجهة والتعا

 .ملموس

 الكلمات المفتاحية: الحساب بمساعدة الحاسوب، إتابس، الواجهة
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INTRODUCTION GÉNÉRALE 

 

Le présent polycopié intitulé Calcul Assisté par Ordinateur «Calcul Assisté par 

Ordinateur avec le logiciel ETABS», s’adresse aux étudiants de troisième année LMD en 

Génie Civil. Il met l’accent sur le dimensionnement des éléments d’une structure soumise 

à plusieurs sollicitations. 

Objectifs de l'enseignement consiste à familiariser les étudiants avec les logiciels de 

calcul utilisés en génie civil. Il est nécessaire pour l'étudiant de comprendre les 

caractéristiques essentielles d'un logiciel de calcul, en se basant sur un projet existant, et 

de maîtriser l'interface du logiciel, de saisir correctement les données et de récupérer les 

résultats demandés. Recommandations de connaissances préalables : 1 et 2 Informatique 

et informatique 

Au cours des premiers travaux pratiques, les étudiants acquerront les concepts 

fondamentaux des logiciels de calcul, ainsi que le fonctionnement et les méthodes de 

calcul utilisés. Ils étudieront les logiciels fermés, les logiciels ouverts, ainsi que les 

avantages et les limites des logiciels. Ensuite, arrive l'étape de la L'utilisation d'un 

logiciel disponible (comme ETABS) implique la présentation de l'interface, de 

l'environnement de travail, des données, des options, des résultats (numériques et 

graphiques), ainsi que l'interprétation. Et enfin, l'analyse et le suivi d'un projet concret. 
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1. Introduction 

La conception assistée par ordinateur ou CAO (en anglais, computer aided design ou 

CAD) comprend l'ensemble des logiciels et des techniques de modélisation géométrique 

permettant de concevoir, de tester virtuellement – à l'aide d'un ordinateur et des 

techniques de simulation numérique – 

ETABS est l’un des logiciels de calcul conçu exclusivement pour le calcul des bâtiments. 

Il permet de modéliser facilement et rapidement tous types de bâtiments grâce à une 

interface graphique unique. Il offre de nombreuses possibilités pour l’analyse statique et 

dynamique. Ce logiciel permet la prise en compte des propriétés non-linéaires des 

matériaux, ainsi que le calcul et le dimensionnement des éléments structuraux suivant 

différentes réglementations en vigueur à travers le monde (Euro code, UBC, ACI..etc). 

 

2. Concept de base sur les logiciels de calcul CAO 

 

La Conception Assistée par Ordinateur (CAO) est l’ensemble des outils logiciels et des 

techniques informatiques qui permettent d’assister les concepteurs dans la conception et la 

mise au point d’un produit.  

 

             2.1. Definition du logiciel de calcul ETABS  

ETABS est l’abréviation de «Extented Three Dimentional Analysis of Building 

Systems», c’est un logiciel intégré ultime pour l’analyse structurelle et la conception de 

bâtiments. Il offre des outils de modélisation et de visualisation 3D inégalés, une puissance 

analytique linéaire et non linéaire incroyablement rapide, des capacités de conception 

sophistiquées et complètes pour une large gamme de matériaux, et des affichages 

graphiques, des rapports, et des dessins schématiques qui permettent aux utilisateurs de 

déchiffrer et de comprendre rapidement et facilement les résultats de l’analyse et de la 

conception. 

De plus de part ça spécificité pour le calcul des bâtiments, ETABS offre un avantage 

certain par rapport au codes de calcul à utilisation plus étendue. En effet, grâce à ces 

diverses fonctions il permet une décente de charge automatique et rapide, un calcul 

automatique du centre de masse et de rigidité, ainsi que la prise en compte implicite 

d’une éventuelle excentricité accidentelle. Il permet également le transfert de donnée 

avec d’autres logiciels (AUTOCAD,SAP2000 et SAFE). 

2.2 .Modélisation  

Le but de la modélisation est de développer des modèles capables de décrire 
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approximativement le comportement d'une structure dans différentes conditions. 

Actuellement, il existe un certain nombre de programmes basés sur la méthode des 

éléments finis (FEM) qui permettent le calcul automatique de diverses structures. 

Les ingénieurs peuvent donc ignorer le principe MEF. Il suffit de savoir utiliser le 

programme de calcul et de connaître la réglementation applicable.  Cet utilisateur ne peut 

cependant pas modifier les résultats fournis par l'ordinateur. 

Par conséquent, il est essentiel que tous les ingénieurs comprennent les bases de la FEA et 

comprennent le processus de la phase de résolution. Cette compétence ne peut être acquise 

que par l'étude analytique des concepts MEF et la connaissance des techniques associées à 

l'utilisation de ces outils informatiques. 

 
3. Étapes de modélisation 

 

1. Initialiser le modèle (unités, grilles, niveaux). 

2. Définir les paramètres de l’analyse (matériaux, sections, cas et combinaisons de 

chargements) 

3. Modéliser la structure 

5. Appliquer les charges statiques 

6. Chargement dynamique 

7. Analyse et exploitation des résultats (visualisation graphique, tableaux, 

exportation des résultats) 

8. Ferraillage. 

 

Solution : 

1. Choisir le type d’analyse (statique, dynamique…) 

2. Construire la matrice et le vecteur élémentaire [ ] ,{𝑓𝑒 } 

3. Assembler [ ]  𝑒𝑡 { } dans [𝐾] 𝑒𝑡 {𝐹} 

4. Prendre en compte les conditions aux limites 

5. Résoudre le système d’équations [𝐾] {𝑈}={𝐹} 

6. Calculer les variations additionnelles (réactions, σ, ε…) 

Post-procession: 

1. Présenter les résultats sous forme numérique ou graphique 

2. Effectuer des fonctions complémentaires : combinaisons, interpolations, animation … 

Description de l'outil ETABS : Le programme ETABS (Extended Three-dimensional 

Analysis of Building Systems) est un logiciel leader en ingénierie des structures, créé en 

1984 et édité par Computers & Structures Inc. Ce logiciel est fréquemment utilisé par les 

ingénieurs civils pour le calcul tridimensionnel par éléments finis de bâtiments et des 

ouvrages de génie civil. 

Les principales raisons d'utilisation de ce programme comme un outil de calcul de structures, 

sont qu'il est utilisé pour analyser les structures en béton armé, charpente métallique ou 

autres matériaux de construction et sous n'importe quelle forme de chargement (ponctuel, 
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linéaire, surfacique... etc.). 

Le logiciel traite plusieurs types de chargement statique (poids propre de la structure et 

charges d'exploitation) ou dynamique (séisme). 

 

 

BOUTONS DES FICHIERS: 

1. Créer un nouveau modèle. 

2. Ouvrir un modèle existant. 

3. Enregistrer un modèle dans un fichier. 

4. Annuler une action. 

5. Reprendre une action. 

6. Refranchir la fenêtre. 

7. Verrouiller le modèle après l’analyse. 

8. Lancer les calculs. 

 

BOUTONS D’AFFICHAGE: 

 

 
Figure 2: boutons d’affichage 

1. Zoom fenêtre. 

2. Zoom étendu. 

3. Zoom précédent. 

4. Zoom avant. 

5. Zoom arrière. 

6. Panoramique dynamique : sert à déplacer la vue de dessin. 

7. Permet l’affichage de notre structure en trois dimensions. 

8. Affichage du plan XY. 

9. Affichage de l’élévation selon XZ Ou YZ. 

10. Manipule la vue de la structure. 

11. Offre la perspective de notre structure. 

12. Changer la vue 2D (plan ou élévation) vers le haut. 

13. Changer la vue 2D (plan ou élévation) vers le bas. 

14. Rétrécir les éléments de model visuellement. 

15. Définir les options de vue du la structure. 

 

 

Figure 1 : boutons des fichiers 

 

Figure 1: boutons des fichiers 
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BOUTONS DE DESSIN: 

 
Figure 3: Boutons de dessin 

1. Pointeur utilisé pour une sélection d'un élément en cliquant dessus ou par une 

fenêtre de sélection. 

2. Éditeur d’objet. 

3. Créer un point. 

4. Dessiner un élément unidimensionnel (Poutre ou poteau) (Plan, Elev, 3D) 

5. Créer des éléments unidimensionnels par un clic (Plan, Elev, 3D) 

6. Créer des poteaux par un clic (Plan) 

7. Créer des poutres secondaires par un clic (Plan) 

8. Créer des contreventements par un clic (Elev) 

9. Dessiner des éléments bidimensionnels (Plan, Elev, 3D) 

10. Dessiner des éléments bidimensionnels de forme rectangulaires (plan, élévation) 

11. Créer des éléments bidimensionnels par un clic (Plan, Elev) 

12. Dessiner des murs (plan) 

13. Créer des murs par un clic (Plan) 

14. Créer des fenêtres dans les voiles (Elev) 

15. Créer des portes dans des voiles (Elev) 
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4. Exemple : 

Modélisation d’une Structure béton armée en R+7 à usage habitation. La 

hauteur de tous les niveaux est : 3.06m 

 

 

Sections : 

 Poutres Principale : 35x30 cm 

 Poutres secondaire : 30x30 cm 

 Poteaux : 30x30 cm (6eme étage & Terrasse) 

 Poteaux : 35x35 cm (4eme étage & 5eme étage) 

 Poteaux : 40x40 cm (2eme étage & 3eme étage) 

 Poteaux : 45x45 cm (RDC & 1eme étage) 

 Planchers en Corps Creux 16+4 : 20 cm 

 Voile de contreventement : 15cm 

 Mur : 25 cm 

Matériau : 

 Béton : Fc28 = 25MPa ; E=32164MPa ; ρ = 23500 kg/m3 

 Acier : FeE400 (longitudinales) ; FeE215 (Transversales) 

Charges : 

 Charge permanente : 

 Getage = 5.16 kN/m² 

 GTerrasse = 6.10 kN/m² 

 Charge d’exploitation : 

 Qetage = 1.50 kN/m² 

 QTerrasse = 1.00 kN/m² 

Figure 4: Exemple de modélisation des structures 
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4.1. Initialisation du modèle 

 

 

Figure 5 : démarrer le programme et changer les unités par défaut en (kn-m) 

 

4.2. Commencer un nouveau modèle (File _ New model) : 
 

 

 

 

 

 

 

 

 

 

 

 

1 

2 

Figure 5: Démarrer le programme et changer les unités par défaut en (kn-

m) 

Figure 6: Nouveau modèle 
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4.3. Définir la grille horizontale (Custom grid spacing , Edit Grid) : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.4. Entrer les distance des travées après avoir sélectionné l’option (Spacing) 

 

4.5. Spécifier le nom et la hauteur des étages et Grouper les niveaux similaires (Assigner 

la similarité aux 7 premiers niveaux) : 

 

TERRASSE - MASTER STORY _ NO 

RDC - MASTER STORY _ YES 

H-1ER à H-6EME _ Similar to RDC 

 

 

 

 

 

* 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 7:Définition des grilles 

 

 

Figure 7 : Définition des grilles 

1 2 
6 

3 
4 

5 

 
 

Figure 8: spécification des étages et grouper les niveaux similaires 

 

1 2 
3 
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4.6. Commencer avec un modèle vide (cliquer sur Grid only _ OK) : 

 

 

 

4.7. Changer le règlement par défaut : 

 

 

1 
2 

Figure 9 : modèle vide 

Figure 10: règlement par défaut 
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4.8. Définition des paramètres du modèle 

 

Définition des propriétés de matériaux : 

 

 On définit les propriétés des matériaux avec Define > Material Properties. Visualisation des 

systèmes de coordonnées local : 

 Les systèmes de coordonnées local des éléments de barre peuvent être visualisés avec la 

commande de menu View > Set Building View Options, dans le panneau Object View 

Options de la boite de dialogue Set Building View Options, on coche I’option Line Local 

Axes. 

 Les systèmes de coordonnées local des éléments de plaque peuvent être visualisés en utilisant 

la commande de menu View > Set Building View Options, dans le panneau Object View 

Options de la boite de dialogue Set Building View Options, on coche l’option Area Local 

Axes. 

Définition des propriétés de la section: 

 La définition d’une section de barre s’effectue avec la commande de menue Define > Frame 

Sections. Dans la boite de dialogue Define Frame Section, on choisit le type de section dans la 

boite à liste déroulante Add. 

 Pour importer une section d’un tel fichier on utilise la commande de menu Define > Frame 

Sections. dans la boite de dialogue Define Frame Sections, on choisit le type de section dans 

la boite a liste déroulante Import. 

 Pour définir un type de section de plaque, on utilise la commande de menu Define > 

Wall/Slab/Deck Sections et dans la boite de dialogue Define Shell Sections, qui apparait, on 

clique sur la boite a liste déroulante Add New ... et on choisit le type de section désire. 

 

 

4.8.1. Définir les matériaux (Define _ Material properties) : 
 

 

 

 

1 

2 3 

Figure 11: Définition des matériaux 
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4.8.2. Modifier le matériau BETON par les propriétés suivantes (Ei=32164 Mpa; poids 

volumique 25kN/m3)  
 

 

 

 

Figure 12: Modifier le matériau BETON 
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4.8.3. Définir les sections des poutres et des poteaux (Define _Frame sections) : 

 

Figure 13 : Définir les sections des poutres et des poteaux 

 

Remarque : le paramètre « Concrete Cover to Rebar center » c’est la distance entre 

le coffrage et le centre des armatures, et c’est ce qu’on appelle l’enrobage des 

armatures, ce dernier a pour but de protéger les armatures contre les intempéries. 

4.8.4. Commencer par définir les sections des poutres principales et secondaires 

4.8.5. Puis définir les sections des poteaux : 

 

Figure 14 : définir les sections 

1 2 

3 

4 

6 

5 
7 

5 
1 

2 

6 
3 

4 

7 

Figure 13 : Définir les sections des poutres et des poteaux 

Figure 14: définir les sections 
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Remarque 01 : on peut choisir entre une section du poteau rectangulaire ou bien 

circulaire sur la fenêtre « Reinforcement Data » (Données du ferraillage), on 

peut également choisir le type des armatures transversales 

«Lateral Reinforcement » entre les cadres « Ties » ou bien les cerces 

« Spiral » ). 

On choisit l’option « Reinforcement to be Designed » pour laisser le logiciel 

calcule la section des armatures correspondante. 

 

Remarque 02 : On peut également définir une section spécifique à l’aide de la 

fenêtre « Section Designer », soit une poutre en béton armée sous forme de (I) : 

 

 

Figure 15 : Frame Section  

4.8.6. Puis on va avoir la fenêtre « Section Designer » ci-dessous : 

 

 
 

 

3 

1 

2 
4 

Figure 15: Frame Section 

Figure 16: Section Designer 
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Pour créer une section il suffit juste de choisir la forme correspondante dans  les 

outils de dessin (exemple poutre en (I)) : 

 
 

 

Nous pouvons maintenant modifier les paramètres de la forme en cliquant dessus 

avec le bouton droit de la souris : 

 

 

 

On va avoir une forme comme celle-ci : 

 

1 
2 

Cliquer sur le plan pour 
dessiner la section 

2 

1 
Cliquer sur le bouton 

droit de la souris sur la 
forme 3 

1 

2 3 

Figure 17: Section Designer a 

Figure 18: Section Designer b 

Figure 19: Section Designer c 
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Remarque : On peut ajouter des armatures sur la section soit automatiquement 

(sur la fenêtre des paramètres de la section) ou bien manuellement à partir de la 

commande « Ferraillage ». 

4.8.6. Définir la section du plancher (Define  Wall/Slab/Deck Sections…) : 

 

Remarque : la section « Thickness » signifie l’épaisseur de l’élément (dalle, plancher, 

voile…) dans les 2 cas de sollicitation et de déformation : 

 Membrane (Membrane) : c’est un élément qui travaille à la traction ou bien à la compression 

dans le plan seulement. 

 Bending (Flexion) : c’est un élément qui travaille à la flexion. 

 

4.8.7. Définir les sections des voiles (Define _ Wall/Slab/Deck Sections…) : 

 

 

 

 

1 2 
3 

4 

5 
6 

1 
2 

3 

Figure 20: Définir la section du plancher 

Figure 21: Définir les sections des voiles 
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4.8.7. Définir les cas de chargement (Define _ Static Load Cases…) Charge permanente G 

Charge D’exploitation Q 

4.8.7.1. Ajouter le poids des éléments structuraux à la charge permanente 

 

 

 

4.8.8. Définir les combinaisons de charges (Define _ Load Combinations  

Add New Combo) : 

exemple : ELU = 1,35G + 1,5Q ; ELS = G + Q 

 

 

 

4.3. Modélisation de la structure 

4.3.1. Sélectionner la vue en plan de la TERRASSE : 

1 2 

2 

3 

1 

4 

5 

1 

Figure 22: Définir les cas de chargement 

Figure 23: Définir les combinaisons de charges 

Figure 24: vue en plan de la TERRASSE 
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4.3.2. Modéliser les poutres principales et secondaires : 

 

 

 

 

4.3.3. Sélectionner toutes les poutres puis diviser les à l’intersection des lignes : 

 

 
 

 

4.3.4. Modéliser les poteaux du niveau TERRASSE (30X30)cm : 

 

 

 

 

 

 

1 

2 3 

1 3 

2 

Figure 25: poutres principales et secondaires 

Figure 26: Diviser Les poutres 

Figure 27: poteaux du niveau TERRASSE 

 

 



 

17  

4.3.5. On modifie la section des poteaux des niveaux inferieur ultérieurement 

4.3.6. Ajouter les planchers corps creux 20cm : 

 

 

 

4.3.7. Pour bien visualiser les dalles suivre les étapes suivant : 

 

Figure 27 : visualiser les dalles 

 

Remarque : la flèche dans la dalle représente l’orientation des poutrelles (le 

sens de transmission des charges), elle doit être parallèle au sens des chainages 

(poutres secondaires). 

Le sens porteur (poutres principales) est le sens du portique qui contient la plus 

longue travée (Lmax), dans notre exemple le sens porteur est suivant l’axe Y. 

1 

3 
2 

1 

2 

3 (cocher cette 

case) 

4 

Figure 28: planchers corps creux 

Figure 29: visualiser les dalles 
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4.3.8. Sélectionner tous les éléments du plancher TERRASSE et les copier dans  les 

niveaux au-dessous par la commande « Replicate » : 

 

 

 

 

4.3.9. Modifier les sections des poteaux pour les 6 premiers niveaux : 

4.3.10. Pour faciliter la sélection choisir la vue en élévation puis activer la vue en 

perspective, changer l’orientation de la vue à l’aide du clavier (les flèches). 

 

 
 

 

2 
3 

1 

4 
5 

Figure 30: Sélectionner tous les éléments du plancher 

Figure 31: Modifier les sections des poteaux 
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2 

3 

1 
4 

4.3.11. Modéliser les voiles de contreventement avec « Fixed lenght » pour fixer la 

longueur du voile à 1m : 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.12. Sélectionner le nœud de départ et d’arriver du voile : 

 

 

 
4.3.13. Refaire les mêmes étapes pour tous les voiles qui restants, sachant 

qu’il faut refaire l’option « Fixed lenght » pour chaque voile : 
 

 

1 2 

Figure 32: modéliser le voiles de contreventement a 

Figure 33:  nœud de départ et d’arriver 

Figure 34: mêmes étapes pour tous les voiles 
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4.3.14. Mailler les voiles horizontalement et verticalement si nécessaire, dans 

notre exemple on va mailler les voiles verticalement seulement parce que la 

longueur du voile n’est pas très importante (l’intervalle des mailles est 

compris entre 0.80m et 1.10m environ) 
4.3.15. Tout d’abord sélectionner tous les voiles qui se ressembles vis-à-vis la 

géométrie (dans notre cas on va les sélectionner tous) : 

 

    

 

4.3.16. Aller vers le menu EDIT pour créer un maillage : 

 

 

 

 

 

 

 

2 
3 

1 

2 3 

4 

1 

Figure 35: sélectionner tous les voiles 

Figure 36: créer un maillage 
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2 4 

3 

5 

6 

7 

1 

 

4.3.17. Sélectionner et Encastrer toutes les nœuds de la base (Sélectionner One 

story au coin inférieur droit de la fenêtre pour ne pas appliquer l’encastrement 

dans tous les nœuds de la structure) : 

 

 

 

 

 

 

1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.18. Appliquer le diaphragme pour tous les planchers : 

4.3.19. Sélectionner les plancher un par un tout en commençons par le 1er 
niveau (Haut RDC) jusqu’au dernier (TERRASSE) 

 

3 

2 

Répéter 
l'étape 2 et 3 

jusqu'à 
attendre le 

dernier 
niveau 

Figure 37: Sélectionner et Encastrer toutes les nœuds de la base 

Figure 38: Diaphragme pour tous les planchers 
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1 
2 

3 

4.3.20. Affecter le diaphragme D1 : 

 

 

 

 

 

 

 

 

 

 

 

4.3.20. Vérifier le model s’il y a des erreurs de modélisation : 

 

 

 

4.4. Appliquer les charges statiques 

Pour appliquer les charges, on choisit les éléments où ils sont appliquées (nœuds, 

éléments linéiques, éléments surfaciques). 

Pour appliquer une charge qui se retrouve sur plusieurs étages similaires, il faut 

s’assurer qu’on a choisi l’option Similar Stories en bas à droite dans la fenêtre 

principale : 

 

4.4.1. Une fois l’élément sélectionné on choisit le type de charge à appliquer (dans le 

menu Assign 

 

                                                               

                                                                       

                                            

                                                                     Chargement des nœuds 

                                                                       (ex : Action du séisme ou du vent …) 

Chargement des éléments linéiques (ex : Poutre, 

poteau ...) Chargement des éléments surfaciques 

(ex : Dalle, Voile ...) 

2 

1 

3 

Figure 39: Affecter le diaphragme 

Figure 40: Affecter le diaphragme 
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4.4.2. Chargement du plancher terrasse (élément surfacique) par la charge GTerrasse 

(choisir l’option One Story) : 

 

 

 

 

 

 

 

 

 

 

 

 

 Idem pour le chargement Qterrasse : 

 
4.4.3. Application de la charge de l’acrotère sur la périphérie de la structure : 

 

 

 

 

 

 

 

 

 

 

  
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Figure 41: Chargement du plancher terrasse 

Figure 42: charge de l’acrotère 
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 Idem pour le chargement des chainages (0.3 _ Gterrasse pour les chainages de 

rive et 0.6 _Gterrasse pour les chainages intermédiaires) 

 Remaque : les éléments sélectionné si dessous ont déjà été chargé sous G, 

pour ajouter une autre charge sur les mêmes éléments il faut sélection l’option 

« Add to existing Loads » : 

 

 

 

4.4.4. Refaire les mêmes étapes du chargement pour les autres

 niveaux (sélectionné l’option « Similar Stories » pour faciliter l’opération). 

 

4.5. Chargement dynamique 

 

 

Pour le chargement dynamique (sismique) on va 

adopter la méthode spectrale modale, à l’aide de 

la feuille de calcul (excel) du spectre de réponse. 

 

 

 

 

 

 

 

 

 

 

4.5.1. Déterminer les paramètres sismique de la structure (A, T2, 

, Q , R) voir le RPA 99 version 2003. 

Dans notre cas on va adopter les paramètres suivants : 

 

1 2 

4 

3 5 

Table 1: spectre de reponse 

Table 2: Paramètre sismique 
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4.5.2. Copier les 2 premières colonnes du tableau (voir la fig ci-dessous) et les  mets 

dans un fichier texte : 

 

 

  

Sauvegarder et fermer le fichier texte. 

4.5.3. Introduire le spectre (ficher texte) sur ETABS : 

 

  

2 

1 

2 3 
4 

7 5 

1 

6 
9 

8 10 

Table 3: copier du tableau vers un fichier texte 

Figure 43: Introduire le spectre 
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Remarque : si le message d’’erreur « Running out of memory » s’affiche, il faut 

exécutez ETABS de nouveau et refaire l’opération. 

 

4.5.4. Définir les Cas des charges sismiques Ex et Ey : 

 

3 

2 4 

5 
1 

6 

7 

8 

9 

10 

Figure 44: Cas des charges sismiques Ex et Ey 
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4.5.5. Définir les combinaisons suivant : 

0.8G+Ex 

0.8G+Ey 

G+Q+Ex 

G+Q+Ey 

 

 

Figure 45: Définir les combinaisons 

4.5.6. Définir la masse source pour l’analyse modale (on choisit la source de la masse 

et on ajoute les cas de charge à prendre en compte avec leurs facteurs de 

pondération) : 

 

 

 

 

2 

1 

2 

4 
3 

1 5 

Figure 46: Définir la masse source 
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4.6. Analyse et exploitation des résultats 

 

4.6.1. Spécifier le nombre de mode (généralement le nombre de mode égal au 

nombre de niveau de la structure) : 

 

 

 

4.6.2. Lancez les analyses de la structure (bouton F5) : 

 

 
 

 

4 

1 
2 

3 

6 
5 

Figure 47: Spécifier le nombre de mode 

Figure 48: Lancer les analyses 
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4.6.3. Une fois l’analyse terminée, on peut afficher les déformations de la structure 

pour chaque cas de charge appliqué (Il est préférable de sélectionner une Vue 

d’élévations) : 
 

 

4.6.4. On peut voir plus de détail sur chaque élément en le cliquons comme ci- 

dessus par le bouton droite de la souris : 

 

2 

3 

1 

4 

1 

2 

Figure 49: afficher les déformations de la structure 

Figure 50: Voir plus de détail sur chaque élément 
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4.6.5. On peut aussi exploiter les résultats d’analyse et toutes les informations de la 

structure à partir des tableaux créés par ETABS, toute en choisissons les résultats 

qu’on veut affichée, les cas de charges et les combinaisons. 

 

 

 

 

4.6.6. Remarque : on utilise l’option « Selected only » lorsqu’on veut affichée les 

résultats des éléments sélectionnés sur le modèle seulement. 

 

4.6.7. On peut copier et coller les données du tableau dans un fichier Excel pour 

traitement ultérieur simplement en cliquons sur le menu Edit  Copy entire 

table : 

 

 

 

 

4.6.8. Maintenant à l’aide de ces résultats vous pouvez faire les vérifications de 

stabilité nécessaire pour votre Project. 

3 

2 
5 

1 
4 6 

Figure 51: Exploiter les résultats d’analyse 

Figure 52: Copier et coller les données du tableau 
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4.7. Ferraillage 

4.7.1. Avant de démarrer le calcul du ferrailler il faut tout d’abord changer le 

règlement par défaut, puis lancer les analyses : 

 

 

4.7.2. Choisir les combinaisons correspondante au calcule du ferraillage selon le 

règlement BAEL, dans notre cas, nous n'avons besoin que de la combinaison 

1.35G+1.5Q (ELU) : 

1 

2 

3 

4 

2 
1 3 

5 

4 
6 

Figure 53: Ferraillage 

Figure 54: Choisir les combinaisons 
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4.7.3. Démarrer le calcul du ferraillage : 

 

 

 
 

 

4.7.4. Changer les unités en kN-cm (coin bas droite de la fenêtre) pour que les 

valeurs du ferraillage soient en cm². 

4.7.5. Exploitation des résultats du ferraillage graphiquement tout en choisirons la 

vue en élévation pour mieux visualiser les valeurs : 

Ou bien à partir des tableaux des résultats : 

 

 

Figure 55: Calcul du ferraillage 

Figure 56: Exploitation des résultats du 

ferraillage graphiquement 

 

Figure 57: Exploitation des résultats du ferraillage à partir des tableaux des résultats 
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